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Introduction

This is a BLM Geospatial Learning Pathways presentation. ArcPad 8.0 is presented by the
Montana State Office. This presentation discusses the functionality found in ArcPad 8.0,
including the three toolbars within the ArcPad map window - the Main toolbar, the Browse

toolbar, and the Edit toolbar. Your presenter is Randy Schardt of BLM’s Montana State Office.

Randy Schardt
Hello. My name is Randy Schardt, and I'm a GIS Specialist at the BLM Montana State Office

in Billings, Montana. And my presentation today will cover the basics of ArcPad 8.0 and the

toolbars that are available to the user. So let’'s go ahead and get started.

What is ArcPad: What is ArcPad? ArcPad is an ESRI mobile GIS software for field mapping.
It provides database access, mapping, GIS and GPS integration to users out in the field
through the use of mobile devices. And a few of these mobile devices include the Trimble
Recon, the Trimble Nomad, the Trimble Juno, and the Trimble GeoExplorer. ArcPad

customization is achieved by using the ArcPad application builder.

ArcPad supports the following Windows operating systems. For the desktop, Windows XP,
and for the mobile, Windows CE and Windows Mobile. And Microsoft ActiveSync is the

primary software used to transfer data between the mobile device and the desktop PC.

ArcPad provides a comprehensive set of tools that allow for data capture, navigation within the

ArcPad map, data query, GPS navigation and data editing.

What's New in ArcPad Version 8.0: So let's talk about what's new in ArcPad 8.0. The first is

a new user interface. And this includes icons and toolbars that use less screen real estate
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than in previous versions. Toolbars can be docked, minimized and maximized by the user. A
new desktop tool called the ArcPad Toolbar Manager can be used to either modify the out-of-
the-box toolbars or create custom ones. And the ArcPad startup dialog box has been replaced
by the Open Map dialog box, which can be used to browse ArcPad maps by list or by

thumbnail.

The second is improved GPS user interface. The GPS position dialog box has been replaced

by a new GPS status bar, which is a translucent toolbar that appears at the bottom of the map
screen. ArcPad 8 uses colored visual cues to indicate the quality of the GPS sticks and a
more detailed GPS position information can be displayed on the full screen multi-tab GPS

dialog box.

The third is an enhanced ArcPad Data Manager extension. And this allows users to configure

an ArcPad project for repeated deployment with geoprocessing tools. Additional tools have
also been added to the ArcPad tools in the ArcGIS desktop ArcToolbox application, which

supports using an ArcPad project in geoprocessing and in deploying to mobile devices.

ArcPad Map Window: Let’s go ahead and let’s look at the ArcPad map window. You have
your Quick Action, your Main toolbar, your Browse toolbar and your Draw toolbar. You also
have a Map Navigator, and Lock/Unlock Screen, a North Arrow, a Quick Access Menu, your

Scale Bar, your Panning Frame and your Status Bar.

ArcPad 8.0 Toolbars: Let's go ahead and let’s look at the ArcPad 8.0 toolbars. The ArcPad
tools are organized into four default toolbars. The first is your Main toolbar, which contains the

tools necessary for managing your data. The second is the Browse toolbar, which contains

tools that allow you to explore your data by panning, zooming and retrieving information. You
have your Edit toolbar that allows you to add new data or update your existing data. And
there’s a StreetMap toolbar, which has tools for geocoding and routing with StreetMap data.

Main Toolbar:

So first, let's look at the Main toolbar. You have an Open map, which opens in ArcPad map,
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which has a .apm extension to the file. You have your Save Map. You have your Add Layer,
which adds one or more layers to the current map; your Table of Contents, which opens up
your Table of Contents dialog box; the GPS [Position] window, which activates or deactivates
the GPS; the ArcPad Options, which opens the ArcPad Options dialog box; Refresh, which
refreshes the map; and the Help, which displays a new submenu consisting of all the Help

files.

MainToolbar & Open Map Menu: On the Main toolbar, we have an Open Map menu. And
the first option in the Open Map is New. And you’ll have it display a submenu for creating a
new Quickproject, a Map, a Shapefile, a Quickform, a Graphics Layer or a Photo Layer. The
next is Open Map, which opens an ArcPad map, which is a file that has a .apm extension on it.
You have your Save Map, which saves your current ArcPad map; Save Map As, which saves
the current ArcPad map with a new name and/or in a different folder. You have Map
Properties, which opens the Map Properties dialog box. Recent Maps displays the nine most-
recently-opened maps; Recent Layers, which displays the nine most-recently-added layers;
and your Exit, which closes ArcPad.

New Submenu: Forthe New, there is a submenu for that, and the first is a Quickproject,
which closes the current map and creates a new data capture project with ready-to-use, point,
poly-line and polygon shapefiles.

Next is Map, which closes the current map and creates a new, blank map; Shapefile, which
creates a new shapefile with an optional Quickform and loads it into your current map;
Quickform, which creates a new Quickform for an existing shapefile. The Graphics Layer
creates a new graphics layer and loads it into your current map. And the Photo Layer creates

a new photo layer and loads it into the current map.

Main Toolbar & Add Layer Menu: Next on the Main toolbar is the Add Layer menu. By
clicking Add Layer, it adds one or more layers into your current map. And the Add Data from
Server will add an ArcGIS server, ArcPad service or an ArclIMS image service as a layer to the

current map.



Main Toolbar & Add Layer Menu: For the Main toolbar, under the Table of Contents tool,
you have your window that will come up that will have several different tabs on it. First will be

your Layers tab. This is the data that was added into your current ArcPad project.

Table of Contents / Layers Tab: So let's go ahead and let’s look at some of these things in

the Layers tab.

To turn layers on and off, you would check or uncheck the box underneath the eye [icon].

To make layers editable, you would check the box underneath the pencil [icon]. To the right,
there is an icon that allows you to select a projection for your ArcPad project. The next icon
down displays the map properties for your ArcPad project. You could add layers into your
Layers tab by clicking Add Layers. This icon shows properties for your selected layer. You
can change the drawing order of selected layers. Or you can remove a layer from the ArcPad

map.

Table of Contents / Map Properties: So the Map Properties under the Table of Contents has

several different tabs.

First is your Snapping, and this allows you to set your snapping tolerance. You have a Scale
tab, which shows the current scale of the ArcPad project, and it allows you to set a reference
scale. You have your Extent tab, which allows you to center on an extent or use the full extent
of your layers. You have your Map Properties Bookmarks, which shows your bookmarks that
you've created and allows you to edit these bookmarks or delete bookmarks. And last is the
Projection tab, and this shows the projection of your ArcPad project.

Table of Contents / Layer Properties: The Layer Properties icon under the Table of Contents

brings up the window with these tabs on it.

You have your information and the name. That will be your layer name. The Labels tab allows

you to turn your labels on or off for drawing and to tell what field you want to use for the labels.

The next is Symbology tab, and this shows you the symbology for your layer. The Scale tab

allows you to set a reference, or it allows you to do scale-dependent for the layer. The

Hyperlink tab allows you to set your field for your hyperlink or set your default hyperlink path.
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Your Attributes field shows the attributes for the layer, and it allows you to check, on or off,
what fields you want to see. You have a Transparency tab that allows you to set the

transparency for your layer.

Table of Contents / Legend Tab: Next under the Table of Contents, you have your Legend

tab, and this shows you the legend for your layers that are loaded into the ArcPad project.

Table of Contents / Snapping Tab: Lastly, you have your Snapping tab, and this turns on or

off the snapping for your layers.

Main Toolbar & GPS Active Menu: Next on your Main toolbar, you have your GPS Active
menu. Firstis your GPS Position Window, and this opens or closes the GPS position window.
The GPS Active activates or deactivates the GPS. GPS Tracklog starts or stops the storing of
the GPS points in the tracklog shapefile. The Rangefinder Active activates or deactivates the
rangefinder. The GPS Preferences opens the GPS Preferences dialog box. And the
Rangefinder Preferences opens the Rangefinder Preference dialog box. GPS/Rangefinder
Debug opens or closes the GPS/Rangefinder Debug window. Automatic Map Rotation allows
you to activate or deactivate the automatic rotation of the map based on the GPS direction of
movement. When activated, the top of the map is aligned with the GPS direction and
movement. And the Clear Rotation allows you to clear the map rotation so the map constantly

faces north.

GPS Preferences Tabs: So let's look at the GPS Preferences. Firstis your GPS, and it
allows you to set your protocol, your port and your baud rate. The Capture allows you to turn
on or off your averaging. The Quality allows you to set your PDOP and display your
compulsory warnings. You have your GPS Height. You have your Datum. And you have your
Alerts, and this allows you to turn on or off the visual and audio alerts that you hear when
you're in GPS mode. And then you have your Location tab, and to check on or off to restore

your last location when you were using GPS.

Main Toolbar & Options Menu: Next, on the Main toolbar, we're going to the Options menu.
And the Option opens the ArcPad Options dialog box. The Map Navigator displays or hides

the map navigator. The Scale Bar displays or hides the scale bar. You're able to turn off your
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panning frame by choosing the Panning Frame. Status Bar displays or hides your status bar.
The North Arrow will display or hide your north arrow. The Camera opens the camera tool for
taking stand-alone photographs with a connected camera. The Advanced Settings opens the
Advanced Settings dialog box. The Pack Shapefile packs a shapefile by removing records
flagged for deletion. You are able to reproject a shapefile to another projection or datum. And
you're able to export the ArcPad projection information. You're also able to open the Script
dialog box, which can be used for testing scripts. And then the Tools will open up a submenu

that allows you to open and access properties of ArcPad extensions.

Options Tabs: So let’s look at the Options menu. The first tab on the Options menu is your
Display, and this allows you to set the display units for your ArcPad session, and you can set
the format for your status bar coordinates. This example here is in degrees, minutes, seconds.
The Background allows you to change the color of the background, and you can also change
the color of the highlighted or selected items for your layers. The next option is your Camera,
and this allows you to set the default picture path and the photo quality. The next is your Paths
tab, and this allows you to change the default map and data path and your system file path and
also where your applets are located. The next is your Fonts tab, and you're able to change the
fonts here for your labels. The General tab allows you to change your configuration file, and
you can also turn on or off your map dialog on Startup. For your Favorites tab, this allows you
to turn on or off tools that can be added into your Favorites toolbar.

Main Toolbar & Help Menu: The next thing we’re going to talk about on the Main toolbar is
the Help. For the Help menu, you have Help, which lists all your available Help documents.
The About Extension opens the About ArcPad StreetMap Extension dialog box. And the About
ArcPad opens the About ArcPad dialog box.

Help Submenu: So let's look at the Help submenu. You have your Quick Reference Help,
which displays the quick reference help; the Reference Guide, which is only on the PC, opens
the ArcPad Reference Guide; and the User Guide on the PC opens the ArcPad User Guide.
And on the PC, if you were to select the ESRI Support Center, it would take you to the Internet

browser and take you to the ESRI website.




Browse Toolbar:

Next we're going to talk about the Browse toolbar. The first is the Zoom In and Zoom Out. The
next icon allows you to zoom to the full extent of the map. The next is the Go Back to Previous
Extent, and this will zoom back to the previous extent you were viewing. And ArcPad
remembers the last 10 extents that you have looked at since opening your ArcPad session.
The Identify activates the Identify tool, and this displays the Feature Properties dialog box for
any features you tap while the identified tool is active. Find opens the Find tool. And Clear

Selected Features clears your currently-selected features.

Browse Toolbar & Zoom In Menu: The next is the Browse toolbar, and we’ll look at the
Zoom In menu on the Browse toolbar. The first is a Zoom In, and this zooms in on the map
using the pen. You have the Zoom Out, which zooms out on the map using the pen. Pan will
allow you to pan around the map using the pen. And you can rotate the map at a specific

angle by using the pen.

Browse Toolbar & Zoom Full Extent Menu: The next is the Zoom Full Extent menu. And
the first option is the Fixed Zoom In and Zoom Out, and both of these will zoom in or zoom out
by 25 percent. You have your Zoom To Selected Feature. You have your Center on GPS,
and this only works when your GPS is activated. Zoom Full Extent will zoom to the full extent
of all the layers in the map. And the Zoom To Layer will zoom to the extent of a particular layer

in the map.

Browse Toolbar & Go Back To Previous Extent Menu: Next on the Browse toolbar is to
Go Back to the Previous Extent menu. Go Back to Previous Extent zooms back to the
previous extent you were viewing, and this remembers the last 10 extents that you have
looked at since opening the ArcPad map. Next is the Go To Next Extent, and this zooms
forward to the next extent in the extent history. And this also remembers the last 10 extents
you have looked at since opening the ArcPad map. You have the Create Bookmark, which
allows you to create a spatial bookmark. And then the Zoom To Bookmark zooms to an

existing spatial bookmark.

Browse Toolbar & Identify Menu: Next on the Browse toolbar is the Identify menu. The

Identify activates the Identify tool, and this displays the Feature Properties dialog box for any
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feature that you tap while the identified tool is active. The next is the Measure, and this
measures the distance in the map view in point mode. You have a Radial Measure, which
measures the radial distance in the map using the pen. A Freehand Measure, which measure
distances in the map view in the freehand mode. You have your Hyperlink, which will activate
your Hyperlink tool, and this watches the program associated with the hyperlink field for the
feature that you tap. Next you have your Go To, and this will activate your Go To tool, and this
sets the location you tap to be the current destination for your navigation while the Go To tool
is active. Next you have the Label tool, which activates the Label tool, which displays a label
for the feature closest to the location of the tap. You next have your Advanced Select, which
activates the Advanced Select tool, which displays the Advanced Select dialog box with a list

of features at the location that you tap or drag to.

Edit Toolbar:

Next is the Edit toolbar. The first is the Start/Stop Editing, and this tool is used to start and stop
your editing process. Next is Select [a feature], and this allows you to select any feature you
tap and displays the Feature Properties dialog box for that feature. The Select button is only
available when editing is turned on for one or more layers in the Start/Stop Editing drop-down
list. The [Capture] a point feature activates the point feature type for the data capture. The
Capture a point using GPS will capture a point using the GPS while the GPS is currently on.
Add a [single] GPS Vertex captures a single vertex in the current line or a polygon feature
using the current GPS location. The Add GPS Vertices continuously [from a GPS position] will
continuously capture vertices in the current line or polygon using the current GPS position.
The [Show] Feature Properties opens the Edit form, or Feature Properties dialog box, the
selected feature. And the Offset [polyline and polygon toggle] will activate your offsets for

polyline and polygon data.

Edit Toolbar & Select Menu: The next is your Select menu. And Select activates the Select
tool, which will allow you to select any feature that you tap, and it will display the Feature
Properties dialog box. Select and Vertex Editing activates the Select and Vertex Editing tool,
and this will allow you to select any feature you tap and displays the vertices for that selected
feature. The Select at GPS Position will select a feature at the current GPS coordinates.

Center on Selected Feature centers the map on your selected features without changing the
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current map scale. The Zoom To Selected Feature zooms the map extent to the selected
feature. The Go To Selected Features sets a selected feature to the current destination for

your navigation. And the Clear Selected Feature clears your currently-selected features.

Edit Toolbar & Feature Type Menu: The next is your Feature Type menu. You have
several different options here for your feature type. You can either choose points, line,
polyline, freehand line. You can draw a rectangle, a polygon, an ellipse, a circle or a freehand
polygon. You're also able to have text with a point, text with a polyline, text with a polygon,

text with a rectangle, and text with an ellipse.

Edit Toolbar & Feature Properties Menu: The next thing we’re going to talk about is your
Feature Properties menu. And the Feature Properties opens a Feature Properties dialog box.
Insert Vertices will insert vertices in the selected polyline or polygon. The Append Vertices will
append vertices to the end or tail of a selected polyline. The Move Feature allows you to move
a selected feature to a different location. The Rotate Feature will rotate the selected polyline
or polygon feature. Scale Feature changes the size of the selected polyline or polygon feature
relative to the original size. The Resize Feature changes the size of the selected polyline or
polygon feature. And by choosing the Delete Feature, it will delete the feature that you have

currently selected.

Edit Toolbar & Offset Menu: Next is the Offset menu. And the first is the Offset Point, and
this activates offsets for point data capture. The next is the Offset Polyline or Polygon, and this
activates left or right offsets for the polyline or polygon data capture. You have a Line
Traverse, which activates the line traverse mode for capturing a new polyline or polygon
feature. You have a Radial Traverse, which activates the radial traverse mode for capturing a
new polyline or polygon feature. Set Reference Point A activates a tool for setting a reference
point A to be used for capturing a point or vertex using a single-point offset. You also have a
Set Reference Point B, which activates a tool for setting a reference point B to be used for
capturing a point or vertex using a two-point offset. You have a Segment Polyline, which
activates new polylines that start at the end of the selected polyline. And you have a Repeat

Attributes, which allows you to copy attributes from the previous feature into a new feature.

Command Bar: Next you have the Command bar. And the Command bar is also
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automatically added when a data layer is selected for editing. So the first is you have your
Commit Geometry Changes. Next is Proceed or Complete feature. You have an Undo that
will go back to your previous condition. You have a Toggle Pen for Capture. And you have a
Cancel Feature Edits. And you also have a Display, Hide or Move the Command Bar.

Quick Action: Next let's talk about the Quick Action. This is new in ArcPad 8.0, and it’s
located on the left-hand side of the toolbars. You can choose to assign a single tool, making
the Quick Action button a one-click stop for the most-used tool, or you can choose to assign
multiple tools to create a Quick Action menu. By default, a selection of commonly-used file
tools are listed as a menu. So when you click on the Quick Action, this is the menu that you

see.

Quick Access Menu: Also new in ArcPad 8.0 is the Quick Access menu. And the Quick
Access menu icon is located to the right of the toolbars, and it gives you the options to
minimize the toolbar, which reduces the toolbar area to a thin bar, displaying the maximum
size of the map as possible. You can also maximize the toolbar by double-clicking on the bar.
You are able to dock the toolbar to the top, bottom, left or right of the screen. You're able to
hide or show the Quick Action tool. You're able to hide or show the Taskbar. You're able to
hide or show the Toolbar Selector. You're also able to hide or show any individual toolbar.
You're able to hide or show the Map Navigator or the GPS Status Panel.

Map Navigator: Next let’s talk about the Map Navigator. And the Map Navigator is a
combination of four frequently-used tools. You can Zoom In, Zoom Out, Pan, or Zoom to the
Full Extent, and these operate as “use once only” tools. So you can click on the Zoom In,
zoom in on your map, and then you’ll have to click the Zoom In again to make it operational.
By default, the Map Navigator is active, but it can be hidden by unchecking it in the Quick

Access Menu.

And with that, this presentation is ended for the basic ArcPad 8.0 toolbars.

Questions?
Randall_Schardt@blm.gov
406.896.5141
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